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El departamento de investigación y 
desarrollo planea participar en la licitación 
de un gran proyecto para el desarrollo de un 
nuevo sistema de comunicaciones para 
aviones comerciales. La siguiente tabla 
muestra las actividades, los tiempos y las 
secuencias requeridas.
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Calendario

Gráfica de Gantt

Gráfica PERT

GANTT de Seguimiento

Utilización de tareas

Gráfica de recursos

VIEW – VIEW BAR
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Conceptos Básicos de MsProject Project START & Finish Dates:

Project Start Date: Programación hacia adelante.
Project Finish Date: Programación hacia atrás.



TASK & DURATIONS

ACTV # NOMBRE DE LA ACTIVIDAD

DURACION:
D – días
W- semanas
M - meses

DIAS NO LABORALES
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DIAGRAMA GANTT

TASK MODE

Modificar ESCALA TEMPORAL
VIEW TIMESCALE
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The Project Properties Dialog Box The Task Information Dialog Box



7Schedule Options

Throughout your project planning, you may need to add 
tasks to your project plan to account for the work that 
needs to be completed—especially if you used a template 
as a basis for your plan and now you need to modify it to 
include your project’s specific details. Before you insert 
any new tasks into an existing task list, it’s a good idea to 
modify the schedule options for the project to ensure 
that new tasks are properly scheduled.
You can access these options by selecting the File tab, 
and then selecting Options on the Backstage; in 
the Project Options dialog box, select the Schedule tab. 
In the New tasks created field, make sure that Auto 
Scheduled has been selected in order to automatically 
calculate the task’s parameters in the schedule. Then, 
make sure that the Autolink inserted or moved 
tasks check box is checked, so that Microsoft Project will 
automatically manage the dependencies between the 
tasks for you.
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Duration vs. Work

In project management, the concepts of duration and work are not the same thing. Duration is the amount of working 
time it will take to perform a task from start to finish, measured in a specific unit of time (minutes, hours, days, weeks, 
etc.). Work is the amount of time it will take to complete the task (the duration), multiplied by the level of effort that 
will be given to the task by the resources assigned to it. For example, if the task “secure work permit” has a duration of 
3 days and the resource “Jack” will give 50% of effort to the task, then the work for the task is 1.5 days.
For tasks with a fixed amount of work, then, you can decrease the duration of the task by increasing the effort level 
through more resources. For instance, if the task “perform quality testing” has a duration of 6 days and a single quality 
controller is assigned to the task with 100% effort level, assigning another quality controller to the same task with 
100% effort level would reduce the duration to 3 days.
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Dependencies

A dependency is a relationship between a task and its predecessor. All of these relationships are displayed on 
the Predecessors tab of the Task Information dialog box.
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Task Constraints

A task constraint is a date-based limitation placed on a task in order to control the start and finish dates. The 
constraint parameters are selected from the Advanced tab of the Task Information dialog box.



ACTIVIDAD 
RUTA CRITICA
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• Identificar ruta crítica

• The critical path is the longest path of linked tasks in a
project, calculated by adding all of the durations of
the individual tasks in the path, which determines the
total duration of the project. The critical tasks in this
path drive the end date of the project.

• In short, the project duration cannot be shorter than
the total duration of all of the tasks in the critical path.
In general, a project will only have a single critical
path, though some more complex projects could have
more than one.

• Microsoft Project automatically calculates the critical
path for you, but does not display it for you by default.
In the Gantt Chart view, check the Critical Tasks check
box from the Bar Styles command group on the Gantt
Chart Tools Format tab. Then, tasks in the critical path
will be displayed in red in the Gantt Chart.



HOLGURA (SLACK)
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Holgura total = LS(a) – ES(a) = LF(a) – EF (a)
Holgura libre = mín. (Es (todas las sucesoras de a)) – EF(a)
Holgura total: Cantidad de tiempo en que se puede incrementar la duración de una actividad sin retrasar la terminación del 
proyecto.
Holgura libre: Cantidad de tiempo en que se puede incrementar el tiempo de una actividad sin retrasar el inicio de la actividad 
inmediatamente siguiente.

Nota: El uso de la holgura total en una actividad puede afectar las fechas de inicio de las actividades sucesoras a todo lo largo de la 
red, pero no se afectará la fecha de terminación del proyecto. Si se emplea la holgura libre no se afectarán las fechas de inicio de la 
red.



• Creación de notas en el diagrama de Gantt
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Notas

Agrupación de tareas

Indentación



Baselines
• A baseline is a specific measurement, calculation, or point on some sort of scale that is used as a basis for 

comparison. Your project baseline is a snapshot of the planned scope, time, and cost of the project 
according to the approved project plan. As the project is then executed, you can compare your actual scope, 
time, and cost against the baseline to measure how the project is performing.

• There are a number of questions that you can pose to determine if your project is on track as compared to 
the baseline.

• For scope:
• Are we performing the tasks we planned?
• Are we performing different tasks than we anticipated?
• Are we performing more or fewer tasks than we anticipated?
• For time:
• Are we on schedule?
• Are we behind schedule?
• Are we ahead of schedule?
• For cost:
• Are we on budget?
• Are we under budget?
• Are we over budget?
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El equipo se reunirá cada viernes para revisar el avance del proyecto.
Incluir una tarea repetitiva por los siguientes 20 días 
Insertar - Tarea repetitiva
Juntas 2h
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Recurring Task



• Tipos de dependencias que se pueden definir en MsProject

A

B

A

B

A

B

• Fin a comienzo [Finish to start (FC)] 
El término de una tarea marca el inicio de la 
siguiente

• Comienzo a comienzo [Start-to-start (CC)]
Las dos tareas empiezan simultáneamente

• Fin a fin [Finish-to-finist (FF)]
Las dos tareas terminan simultáneamente
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Dependencias

A

B

• Comienzo a Fin [Start-to-finish
(CF)]
El inicio de una tarea marca el final 
de la otra



Objetivo:

•Aprender a gestionar recursos: las personas, 
equipos, facilitadores y material necesarios 
para llevar a cabo las tareas del proyecto.
• Introducir los recursos en el proyecto y 
asignarlos a las tareas.
•Asignar costos a los recursos 
•Presentación de la información de recursos

•Seleccionar el botón de asignación
de recursos

• Administrar los recursos del proyecto

•Asignar los recursos : 
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•En la barra izquierda seleccionar “hoja de 
recursos”

• Agregar recursos en la “hoja de recursos”

• Seleccionar el icono de la gráfica de Gantt de 
la barra izquierda
• Seleccionar tarea y el botón de asignación de 
recursos

• Asignar recursos a una tarea
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• Dar doble “click” en un recurso de la hoja 
de recursos.
Incluir la información de e-mail 
Seleccionar la disponibilidad del recurso, del 
día actual al 30 de octubre.

• Información de los recursos

Métodos de acumulación de costos:

Inicio .- Se acumulan tan pronto como
comienza la tarea que usa el recurso
Fin .- Si los costos no se acumulan hasta que
la tarea finaliza (costos fijos siempre son
acumulados al final de cada tarea)
Prorrateo .- Se acumulan conforme avanza la
tarea que utiliza el recurso, basándose en el
trabajo realizado (método utilizado por
omisión)
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• As you may already know, allocation is the act of scheduling tasks and the resources to perform them, taking 
into account both resource availability and project duration. Overallocation occurs when a resource has 
been assigned to do more work a project than it can within its normal working capacity.

• For example, if you schedule Jan Kolas to spend 100% of her time on the task to develop the detailed 
hardware design and 50% of her time on the task to develop the detailed software design, and those tasks 
occur simultaneously in the project schedule, then she is an overallocated resource.

• In the Gantt Chart view, tasks with overallocated resources will display an overallocation icon—sometimes 
referred to as the burning man icon—in the Indicators column.
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Overallocation



Methods of Resolving Resource Conflicts

When you identify that there are overallocated work resources in your project plan, 
you need to level them. Leveling refers to the modifications made to a task to 
resolve resource overallocation.
• There are a number of methods you can use to level resource allocation for a 

task:
• Increase the duration of a task. (This approach is used when resources are fixed.)
• Increase the number of resources assigned to a task. (This approach is used when 

task duration is fixed.)
• Reassign the task to another resource that is available.
• Reschedule the task to a time when the resource is available.
• Note: Project managers typically use a combination of these methods to achieve 

a level project.

21



•Work duration, units

Work = Duration * Units (Units = Resources)
Duration = Work/Units

(Adding additional resource units after the initial resource
Assignment, the work will remain constant è “effort-driven”)
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Effort driven
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When you assign or remove people from a task, Project lengthens or shortens the duration of the task based on the 
number of resources that are assigned to it, but Project does not change the total work for the task. This is called 
effort-driven scheduling and is the setting Project typically uses when you assign resources to tasks.
1.Double-click the task.
2.In the Task Information box, click the Advanced tab.
3.Uncheck the Effort driven check box.
You can add the Effort Driven column to a sheet view. Right-click a column heading and then click Insert Column.
Although effort-driven scheduling works most of the time, you may want to change this to more accurately reflect 
what happens when resources are added or removed for a particular task. For example, you may want to see the total 
work increase as you add more people to a task.
Here are some exceptions to watch out for when you change the effort-driven setting.
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Exception Explanation
First assignment Effort-driven calculations apply only after resources are initially assigned to the 

task. After the first resources are assigned, the work value doesn't change as new 
resources are assigned or removed from the same task.

Fixed work tasks You can’t remove effort-driven scheduling from fixed-work tasks. Fixed work tasks 
do not have flexible work values, and are therefore always effort-driven.

Fixed unit tasks If the assigned task type is fixed units, assigning additional resources shortens the 
duration of the task.

Fixed duration tasks If the assigned task type is fixed duration, assigning additional resources 
decreases the individual unit values for resources.

Summary tasks Summary tasks and inserted projects can’t be set to effort-driven.

Inserted projects Inserted projects can’t be set to effort-driven.



When Effort 
Driven is set 

to:

And the Fixed field (task 
Type) is:

If enter the value -
deliberately change:

Then the field that will 
recalculate is:

Any notes or comments:

Yes Fixed Duration Work Units (Resources) If Effort Driven is Yes, then the Work should not be 
changing

Yes Fixed Duration Units (Resources) Work

Yes Fixed Duration Duration Work If changing the Duration field, then the duration is not 
fixed and so this setting is least appropriate when 
changing the duration field

Yes Fixed Work Units (Resources) Duration

Yes Fixed Work Duration Units

Yes Fixed Work Work Duration If changing the Work field, then the work is not fixed 
and so this setting is least appropriate when changing the 
work field.

If Effort Driven is Yes, then the Work should not be 
changing.

Yes Fixed Units Duration Work This does not make sense if Effort Driven means total 
amount of work on a task stays the same regardless of 
number of resources assigned

26



Yes Fixed Units Work Duration If Effort Driven is Yes, then the Work should not be 
changing

Yes Fixed Units Units (Resources) Duration If changing the Units field, then the units are not fixed 
and so this setting is least appropriate when changing the 
Units field

No Fixed Duration Work Units

No Fixed Duration Units (Resources) Work

No Fixed Duration Duration Work If changing the Duration field, then the duration is not 
fixed and so this setting is least appropriate when 
changing the duration field

No Fixed Work Units (Resources) NA Impossible – Fixed Work can’t be non-effort-driven

No Fixed Work Duration NA Impossible – Fixed Work can’t be non-effort-driven

No Fixed Work Work NA Impossible – Fixed Work can’t be non-effort-driven

No Fixed Units Duration Work

No Fixed Units Work Duration

No Fixed Units Units (Resources) Work If changing the Units field, then the units are not fixed 
and so this setting is least appropriate when changing the 
Units field
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Objetivo:

• Introducir vacaciones

•Crear nuevos calendarios bases

•Modificar los días de trabajo estándar

•Modificar la jornada laboral estándar

•Asignar recursos a un nuevo calendario base

•Editar calendarios de recursos

Calendarios

• Ver opciones de calendario
File - Options
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Base Calendars
• A base calendar defines the 

working days and working hours 
that can be used when assigning 
tasks and resources to the 
project. The base calendar that is 
assigned to your project can be 
viewed in the Calendar field in 
the Project Information dialog 
box. The Standard base calendar 
is the default for all new files you 
create, but you can change it to 
one of the other built-in base 
calendar options from 
the Calendar drop-down.

• The base calendar options 
include the following.
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Base Calendar Description

Standard Monday through Friday
8:00 AM to 12:00 PM
1:00 PM to 5:00 PM

Night Shift Tuesday through Friday
12:00 AM to 3:00 AM
4:00 AM to 8:00 AM
11:00 PM to 12:00 AM
Saturday
12:00 AM to 3:00 AM
4:00 AM to 8:00 AM

24 Hours 24 hours a day
7 days a week
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The Change Working Time Dialog Box

Working time refers to any time when labor is being
performed on a task or by a resource in order to complete
the project. Nonworking time refers to any time when labor
is not being performed. Depending on your organization’s
typical work schedule, you may have different working and
nonworking time than what is defined in the default hours
of Microsoft Project’s base calendar. If so, you can create a
base calendar that defines your organization’s working and
nonworking dates and times, including any holidays that the
company observes, and apply it to the project.
To modify working time, select the Project tab on the
ribbon, and then select the Change Working Time button in
the Properties command group. In the Change Working
Time dialog box, you can view and change working time via
the calendar that is displayed.
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Appearance Meaning
Working Labor will be performed during the defined working hours on 

this date.
Nonworking Labor will not be performed during the defined working hours 

on this date. This typically includes weekends and holidays.

Edited working hours The hours during which labor will be performed on this date 
have been changed to something other than the normal 
working hours.

Exception day The hours during which labor will be performed on this date 
are different than the normal working hours. For instance, an 
organization may only be operating during the morning on the 
day before a major holiday.

Nondefault work week The hours during which labor will be performed during this 
entire week are different than the normal working hours. For 
instance, an organization may shut down operations for an 
entire week if a majority of employees will be out on vacation.

The Legend on the left side of the 
calendar provides a brief explanation 
of how each type of time appears in 
the calendar, and the table below 
provides a more detailed description 
of each classification.



Exceptions
• In Microsoft Project, an exception is any date (or dates) when the defined working time is different than the normal working time in the 

base calendar. Often, an exception will be a holiday that you have added to your base calendar. All of the exceptions for the selected 
base calendar are displayed in the Exceptions table below the calendar in the Change Working Time dialog box.

• You can add an exception to the base calendar by selecting a date in the calendar in the Change Working Time dialog box and entering 
a name for the exception in a blank row in the Exceptions table.
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Working Time vs. Non-Working Time for Exceptions
By default, when you add an exception to your base calendar, it
is automatically added as an entire day of nonworking time.
However, if the organization will actually be working some of
the day—say, just the morning of the day before a major
holiday—you can make part of the day working time and part
of the day nonworking time. You can do so by selecting the
exception in the Exceptions table and then selecting
the Details button.
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The Details Dialog Box

In the Details dialog box, you can view and modify the
specific details for the selected exception. Here, you can set
the desired working times for the exception and even set up
a recurrence for the exception. For instance, if your
organization needs to stay open for a few nights in a row to
perform an inventory, you may extend the working times for
the exception date and set up a recurrence to repeat daily
for the next three days. The recurrence feature is also
useful for a holiday that does not change from year to year
(for example, Labor Day is the first Monday in September).



• Cambiar el calendario base

• Crear un nuevo calendario base

Tools – Change working time
• Nombre : Late Shift

• Revisar que esté la opción de copiar del calendario 
estándar
• Cambiar el horario en este calendario de Lunes a 
Viernes de 3 pm a 7 pm y de 7:30 pm a 11:30 pm
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Cambiar horario de trabajo para un día específico



• Asignar recursos a diferentes calendarios base
Abrir la “hoja de recursos”
Seleccionar un recurso
Seleccionar “Horario de trabajo”
Seleccionar el calendario para Late Shift

• Presentar el proyecto en 
forma de calendario

Ver - Calendario
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• Ver recursos de cargas de trabajo nos permite 
saber si hemos planeado más capacidad de la 
disponible en algunos recursos o cuales recursos 
están planeados por debajo de su capacidad.

•Cuando un curso tiene planeada más capacidad de 
la disponible nos aparecerá en rojo

Cargas de trabajo Ver cargas de trabajo

•Seleccionar la vista de “uso de recursos”
• Seleccionar un recurso
• Ir a la tarea seleccionada
• Con F5 seleccionar ir a una fecha determinada
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Automatic Resource Leveling

• In Microsoft Project, you can also automatically level
overallocations. Leveling works by splitting tasks or adding a
delay to tasks until the resources that are assigned to them are
no longer overallocated. When performing this automatic
leveling, Microsoft Project does not change who is assigned to
each task and does not level the material resources, cost
resources, or proposed resources; it only levels the work
resources, generic resources and committed resources.
Because of these changes, leveling can delay the finish date of
some tasks and, consequently, also delay the project’s finish
date.

• Note: Prior to leveling, you may want to set the task priorities
in the Task Information dialog box. The priority sets the task’s
importance in the schedule and its availability for leveling.
Tasks that have lower priority are delayed or split before those
that have a higher priority.
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Command Function

Level Selection The selected tasks will be leveled 
according to the settings configured in 
the Leveling Options dialog box. This 
command is only active when you 
select two or more tasks.

Level Resource The selected resource will be leveled 
according to the settings configured in 
the Leveling Options dialog box.

Level All All overallocated resources will be 
leveled according to the settings 
configured in the Leveling 
Options dialog box.

Leveling Options The Leveling Options dialog box 
opens, where you can choose how 
Microsoft Project will level your 
resources.

Clear Leveling Any leveling you previously applied to 
the project plan will be undone. If two 
or more tasks were selected, only the 
leveling for those tasks will be cleared.

Next Overallocation The next overallocated resource in the 
project plan is selected.



The Resource Leveling Dialog Box
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You can control how Microsoft Project levels your resources by
selecting Leveling Options and then setting the leveling parameters in
the Resource Leveling dialog box.

There are many options that can be configured from the dialog box:
•You can choose between Automatic and Manual for how leveling calculations
will be made.
•You can choose by which unit of time that overallocations will be identified.
The default is Day by Day, but you can also choose from Minute by
Minute, Hour by Hour, Week by Week, or Month by Month.
•You can choose whether to clear old leveling values before applying the new
leveling calculations.
•You can choose whether to level the entire project or only for a specific period
of time that you select.
•You can choose the order in which tasks will be leveled. The default
is Standard, but you can also choose from ID Only or Priority, Standard.
•You can choose which built-in leveling rules are followed when resolving
overallocations.
From within the dialog box you can also choose to clear any leveling you have
already applied to the project plan or choose to level all overallocated resources
using the parameters you just set.
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Nivelación de recursos
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NIVELACIÓN AUTOMÁTICA DE RECURSOS



Revisar cambios 
automáticos de nivelación

Los días originales de la tarea aparecen 
en verde mientras la nueva 
calendarización aparece en azul

Nivelación de cargas de trabajo
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• Incrementar las unidades máximas de los recursos

•Seleccionar un recurso
Ir a la sobreasignación
Dar doble click a un recurso
•Aumentar las unidades a 200%
Se resolvió el problema de sobre asignación

• Cambiar trabajo en una tarea asignada
Eliminar las horas de trabajo de una tarea 

Tarea con un recurso sobre-asignado.
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Resolver sobreasignacionesmanualmente



• When you identify that there are overallocated work resources in your project 
plan, you need to level them. Leveling refers to the modifications made to a task 
to resolve resource overallocation.
• There are a number of methods you can use to level resource allocation for a 

task:
• Increase the duration of a task. (This approach is used when resources are fixed.)
• Increase the number of resources assigned to a task. (This approach is used when 

task duration is fixed.)
• Reassign the task to another resource that is available.
• Reschedule the task to a time when the resource is available.
• Note: Project managers typically use a combination of these methods to achieve 

a level project.
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Methods of Resolving Resource Conflicts



The Leveling Gantt Chart
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When you utilize Microsoft Project’s automatic leveling function, many changes will be made to your project plan without you seeing
them. It may be useful to review these modifications using the Leveling Gantt Chart, which shows you a comparison of your project
plan before leveling and after leveling. In the Leveling Gantt Chart, each task will appear with two different colored bars, one for its
placement in the project schedule before leveling and for after leveling. You can also view the delay caused by leveling in the Leveling
Delay column.

If you are not happy with the changes made through automatic leveling, you can clear the changes and either make adjustments to
the Leveling Options and try again or you identify which tasks need adjustments and make them manually.



Calendarizar tareas con restricciones
•Aplicar una restricción flexible

Restricciones
•Aplicar una restricción inflexible
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•Meter información del progreso actual

Seguimiento

Tracking: Línea de seguimiento

Tracking – Update Task
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Actualizar el proyecto según la calendarización • Comparación de la línea base a datos actuales
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Línea de progreso
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Reportes All – Critical Tasks
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Visual Reports

• With the Visual Reports feature, you can export your project data to another application that can display it in a more 
visual manner, such as Excel or Visio. You can choose what fields (including custom fields) to display in a visual report while 
viewing it and modify how it is displayed directly in the application, without having to run the report in Microsoft Project 
again.

• When a visual report is generated in Excel it displays as a PivotTable, which contains data from the project plan; and a 
PivotChart, which is an interactive chart that graphically represents that data in the PivotTable. The PivotChart can help 
you visualize your project data so that you can easily see patterns and make comparisons. Once the report has been 
generated, you can make changes directly to it by filtering the content or changing the layout.

• When a visual report is generated in Visio it displays as a PivotDiagram, which is a collection of shapes arranged in a tree 
structure that helps summarize data in a visual, easy to understand format. The PivotDiagram can be manipulated to 
display your data in various ways, and is especially useful for viewing hierarchies like the work breakdown structure. Once 
the report has been generated, you can customize the diagram and perform calculations directly in the application.
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5.2.11 The Visual Reports Dialog 
Box

• The Visual Reports command is found 
on the Export command group on 
the Report tab. When you select it, 
the Visual Reports - Create 
Report dialog box opens, where you 
can choose which built-in Excel or Visio 
template you want to use and what 
timescale to include in the report. The 
report that is generated will 
automatically open as a new file in its 
respective application. You can then 
view and modify the file to suit your 
needs, and save it in the generated file 
format.
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Built-In Reports

• Microsoft Project has a number of built-in reports, which you access from the View Reports command group on 
the Report tab. The built-in reports are grouped into four types, and can be found on their respective command drop-
downs: Dashboards, Resources, Costs, and In Progress.

•
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Dashboard Reports
Dashboards are dynamic reports that show project status and important indicators. There are five dashboard reports, each 

of which provides a different eye-catching view of project information.

Report Type Description Use

Burndown Displays two side-by-side line charts. The Work 
Breakdown chart shows how much work has 
been completed and how much is left. 
The Task Burndown chart shows how many 
tasks have been completed and how many are 
left.

To see if your project is ahead of 
schedule, on schedule, or behind 
schedule.
For instance, if either the Remaining 
Cumulative Work or Remaining 
Tasks line is steeper than the others, 
then the project might be tracking 
behind schedule.



Cost Overview Displays three widgets showing the total cost, remaining cost, and percent 
complete, and two charts and a table illustrating the status of project costs. 
The Progress Versus Cost shows progress made versus the cost spent over time. 
The Cost Status table shows the cost status for the top-level tasks in a table 
format, while the Cost Status chart shows it graphically.

To see if your project is under budget, on 
budget, or over budget.
For instance, if the Cumulative Percent 
Complete line is below the Cumulative 
Cost line, your project may be over budget.

Project Overview Displays a widget showing the percent complete, and a chart and two tables 
illustrating the status of project tasks. The % Complete chart shows the status for 
all the top-level tasks. The Milestone Due table shows milestone tasks that are 
due to be completed soon. The Late Taskstable shows tasks that are past due.

To see how much of your project is complete.

Upcoming Tasks Displays a widget showing the percent of work complete, and a chart and a table 
illustrating tasks that are starting or finishing within the next week. The Tasks 
Starting Soon table shows the status of tasks scheduled to start in the next 7 
days, while the Remaining Tasks chart shows the status of tasks scheduled to 
finish in the next 7 days.

To see how much of your project still needs to 
be completed, and which tasks are scheduled 
to be completed soon.

Work Overview Displays three widgets showing the percent of work complete, the remaining 
work, and the actual work and four charts illustrating work and resource data. 
The Work Burndown chart shows how much work has been completed and how 
much is left. The Work Stats chart shows how much work has been completed 
and how much is left for the top-level tasks. The Resource Stats chart shows how 
much work has been completed and how much is left for each resource. 
The Remaining Availabilitychart shows the remaining work availability for each 
resource.

To see how much work has been completed 
and how much work still needs to be 
completed.
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Resource Reports

• Resource reports show important information about the resources assigned to your project. There are two resource 
reports, each of which provides a different view of your resource information.
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Report Type Description Use
Overallocated Resources Displays two charts illustrating information 

about your overallocated resources. The Work 
Status chart shows the actual and remaining 
work for overallocated resources. 
The Overallocation chart shows surplus work 
assigned to overallocated resources.

To see which resources are assigned 
more work than they can accomplish 
in the time allotted.

Resource Overview Displays two charts and a table illustrating 
information about your project resources. 
The Resource Stats chart shows how much 
work has been completed and how much is 
left for each resource. The Work Status chart 
show the percent of work completed by each 
resource. The Resource Status table shows the 
amount of remaining work for each resource.

To see the status of all project 
resources.



Cost Reports

• Cost reports show important information about the costs associated with your project. There are five cost reports, each 
of which provides a different view of your cost information.
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Report Type Description Use
Cash Flow Displays four widgets showing the actual, baseline, and remaining costs and 

the cost variance, and a chart and a table illustrating the overall project 
costs. The chart shows the project’s cumulative cost and cost per quarter. 
The table shows cost information for all top-level tasks.

To see how much has 
been spent on the project 
to date.

Cost Overruns Displays two charts and two tables illustrating how much has been overspent 
on project tasks and resources. The Task Cost Variance chart and table show 
cost variance for all top-level tasks. The Resource Cost Variance chart and 
table show cost variance for each resource.

To see which tasks and 
resources are over 
budget.

Earned Value 
Report

Displays three widgets showing the estimated cost at completion (EAC), the 
actual cost of work performed (ACWP), and the budgeted cost of work 
performed (BCWP) and three charts illustrating the earned value for the 
project. The Earned Value Over Time chart shows the project’s earned value 
over the life of the project to date. The Variance Over Time chart shows cost 
and schedule variances over the life of the project to date. The Indices Over 
Time chart shows cost and schedule performance indicators over the life of 
the project to date.

To see if the project is 
behind schedule or over 
budget.



Resource Cost Overview Displays two charts and a table illustrating 
overall resource costs. The Cost Status chart 
shows the current cost associated with each 
resource. The Cost Distribution chart shows 
how costs are spread out over the different 
types of resources. The Cost Details table 
shows cost details for each resource.

To see the cost status for all project 
resources.

Task Cost Overview Displays two charts and a table illustrating 
overall task costs. The Cost Status chart shows 
the current cost associated with each task. 
The Cost Distribution chart shows how costs 
are spread out over the tasks in the project 
plan. The Cost Details table shows cost details 
for the top-level tasks.

To see the cost status for all project 
tasks.
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In Progress Reports

• In Progress reports show how your active tasks and pending milestone tasks are currently performing. There are four in 
progress reports, each of which provide a different view of your project’s progress.
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Report Type Description Use
Critical Tasks Displays a pie chart and a table illustrating the current status of all tasks 

on the critical path.
To see the progress of all tasks on 
the critical path.

Late Tasks Displays a pie chart and a table illustrating all the tasks that are currently 
tracking late according to the schedule.

To see which tasks are behind 
schedule.

Milestone Report Displays three tables and a chart illustrating the current status of the 
project’s milestones. The Late Milestone table shows milestones that are 
past due. The Milestones Up Next table shows milestones that are due in 
the next 30 days. The Completed Milestones table shows milestones that 
are 100% complete. The chart tracks the remaining scheduled tasks 
against the remaining actual tasks.

To see the status of all milestones 
for the project.

Slipping Tasks Displays a chart and a table illustrating all tasks that are currently behind 
schedule. The chart tracks the remaining cumulative work against the 
remaining cumulative actual work. The table shows slipped tasks (where 
the finish date is beyond the baseline finish date).

To see which tasks have been or 
will be completed later than 
planned.



The New Report Command

• In addition to the numerous built-in reports in Microsoft Project, you can also create your own custom reports to meet 
your specific needs. You start by selecting the New Report command in the View Reports command group, which provides 
you with four types of reports that you can create: Blank, Chart, Table, or Comparison.
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Format Bar Styles

• To call attention to specific tasks in your project plan, such as a milestone or summary task, you can customize how they appear in
the Gantt Chart using the Format Bar Styles command from the Format Bar Styles drop-down in the Bar Styles command group. In
the Bar Styles dialog box, you can select from a variety of customization options to change the appearance of the task bars—such
as their color, shape, or pattern—for specific types of tasks, in order to distinguish them from each other in the Gantt Chart.
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Note: You can also change the appearance of just a single, selected task using the Format Bar command from 
the Format Bar Stylesdrop-down.



Task Path

• With a more complex project, the
information displayed in the Gantt Chart
might start to get a little overwhelming
with so many multi-colored bars and
task link lines. To help you sort this out
visually, Microsoft Project has included
the Task Path feature, which highlights
how tasks are linked to each other in
the schedule.

• With Task Path, you can select any task
in the task list and then view the chain
of predecessor tasks and successor
tasks that are linked to it. You can also
differentiate between and view driving
predecessors and driven successors,
whose scheduling is driven by the
selected task. You can choose to display
one, all, or any combination of these
task types for the selected task in the
Gantt Chart. With the task selected,
simply choose the type of tasks you
want to see in the connected chain from
the Highlight Task Path drop-down from
the Bar Styles command group on
the Gantt Chart Tools Format tab.
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Task Progress

• When the project is in the execution phase and work is being performed against the tasks, you need to capture your task 
progress in order to keep the project plan up to date. Task progress can include the actual start date that work began, the 
percentage of work that has been completed, and the actual or projected finish date of the task given the other two 
factors.

• When you update the progress on a task, Microsoft Project may automatically update the amount of work completed and 
the associated cost depending on the task’s settings. Additionally, any auto-scheduled successor tasks that are dependent 
on the task you are updating will be automatically rescheduled if the update causes a change in the dependency date. For 
example, if you complete a predecessor task a day early, Microsoft Project may assume that the successor task that is 
supposed to start when the predecessor finishes can also start a day early.

The Status Date Dialog Box
• A status date is a date that you set within Microsoft Project that you will use to report on your project’s status. When you 

update your task status, you can specify whether that status is as of the current date or as of the status date. For example,
if your team reports their task status to you on Friday and you enter your updates on the following Monday, you can set 
the status date to the previous Friday’s date so that your reporting and estimates are accurate.

• You can use the Status Date dialog box to change the status date for the project. You can access it from 
the Status command group on the Project tab.
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The Mark On Track Command

• The Mark on Track command will update a selected task so that it is on schedule as of the status date. Based on the dates and durations for the task and 
the amount of work that could have been completed for the task in that time frame, it will update the percent that a task is complete and the actual (or 
already utilized) and remaining amount of time in the task’s duration. For example, if you have a task that is scheduled to last two weeks and work is 
progressing as it should after the first week, selecting the Mark on Trackcommand will update the progress to 50% complete as of the status date. You 
can even select multiple tasks and mark them as on track as of the status date all at once.

• The Mark on Track command is accessed from the Mark on Track drop-down in the Schedule command group on the Task tab.
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The Update Tasks Dialog Box

• If you need or want even more control over updating a task, you can use the Update 
Tasks command from the Mark on Track drop-down in the Schedule command group. The 
command opens the Update Tasks dialog box, where you can update the task progress manually, at 
a much more detailed level.

• One of the task progress updates that you can make in the Update Tasks dialog box is to a task’s 
actual start and finish dates. For instance, if a task did not start on the date in which it was 
supposed to according to the project plan, you should update the actual start date of the task in 
order to prevent its delay from affecting the entire project (as would possibly happen if you just 
marked the task on track) and to maintain an accurate record of the project’s progress. Or, if a task 
that started on schedule ends before or after the planned finish date, you should update the actual 
finish date of the task.



Tracking Progress Against Duration

• There are a number of values that you can update for a task within the Update Tasks dialog box in order to track its progress 
against its duration.
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Value Description
Percent 
complete

The percent complete is the amount of the task that has been completed, as a percentage of total 
completion. A task that has not been started is 0% complete and a task that is finished is 100% complete. 
When a task is in progress and you want to update its progress in the project plan, you can enter a 
percentage value between 0 and 100 to represent the task’s status. This amount is displayed and updated in 
the % Completefield.
For example, you could specify that the Develop detailed software design task is 80% complete based on the 
amount of time that has passed in the schedule for that task.
If you enter a value in the % Complete field, Microsoft Project will automatically calculate and update the 
actual duration and remaining durations values.

Actual duration The actual duration is the amount of the scheduled duration that has been spent on a task to date, 
calculated as the scheduled duration multiplied by the percent of duration complete. This value is displayed 
and updated in the Actual dur field.
For example, if the task Review hardware vendors has a scheduled duration of 5 days and the task is 20% 
complete, the actual duration is 1 day.
If you enter a value in the Actual dur field, Microsoft Project will automatically calculate and update the 
percent complete and remaining duration values.



Note: Values in the Update Tasks dialog box fields are not updated in real time. In order for Microsoft Project to perform its calculations and 
update the other fields accordingly, you need to click OK in the dialog box. When you open the Update Tasks dialog box for that same task again, 
the fields will all be updated to reflect the appropriate values.

Remaining 
duration

The remaining duration is the amount of the scheduled duration that is left for the task to be completed. If you 
enter a value for actual duration, it is calculated as the scheduled duration minus the actual duration. If you 
enter a value for percent complete, it is calculated as the scheduled duration minus the actual duration 
multiplied by the percent complete. This value is displayed and updated in the Remaining dur field.
For example, if the task Secure necessary architectural resources has a scheduled duration of 3 days and 2 days 
have been spent on the task, the remaining duration is 1 day. Or, if 50% of the task has been completed, the 
remaining duration is 1.5 days.
If you enter or edit a value in the Remaining dur field manually, Microsoft Project calculates a new task duration 
and updates the percent complete. If time has already been spent on the task, the actual duration would not 
change.
For example, the task Obtain feedback/input on design has a scheduled duration of 4 days, and 3 days of the 
task have already passed but the reviewers need an additional 2 days. You would need to update the task by 
adding 2 days to the remaining duration value. The actual duration would stay the same, but the percent 
complete will update to reflect the amount of the task that has been finished according to the duration and the 
project schedule will change to reflect the additional time needed for the task.
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The Work Table

• The Work table displays information 
about the work that is scheduled for 
your project.

• Note: You can insert columns in the 
table to show additional fields, such 
as Actual Overtime Work, which you 
can use to track your progress again
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Tracking Progress Against Work
• There are a number of values that you can view—and, in the case of the work that has already been performed, update—

for a task within the Work table in order to track its progress against work effort.
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Value Description
Actual work Actual work is the amount of work that has already been completed by your resources for the assigned task. This amount 

is displayed and updated in the Actual Work field.
For example, the resource assigned to the Review software vendors task may have worked 24 hours on the task during 
that status week, and that needs to be captured as progress against the scheduled work for the task and the project.
If you enter a value in the Actual Work field, Microsoft Project calculates and updates the amount of actual work for the 
summary task(s) and project summary task, the amount of work remaining for the task, the percent of work complete on 
the task.

Actual overtime 
work

Actual overtime work is the amount of overtime work—work scheduled to take place beyond the resource’s normal 
working hours— that has already been spent by your resources for the assigned task. This amount is displayed in 
the Actual Overtime Workfield, if it has been added.
For example, the resource assigned to the Define system requirements task may have worked 8 overtime hours in order 
to complete the task, above and beyond the 40 hours that was originally scheduled for the task.
Note: Overtime work and actual overtime work are assigned and updated in the Task Usage table. Once added there, you 
can insert the respective columns in the Work table and the associated values will display. Assigning and utilizing overtime 
will affect your costs.

Remaining 
work

Remaining work is the amount of work still scheduled and/or required for the task to be completed. It is calculated as the 
amount of work scheduled minus the amount of actual work already completed. This amount is displayed in the Remaining 
Work field.
For example, if the resource assigned to the Define target performance metrics task has already performed 12 hours of the 40 
hours of work assigned to them, the task has 28 hours remaining.



The Cost Table

• The Cost table displays information about the costs associated with the tasks and resources for your project. There are a 
number of values that you can view—and, in the case of the fixed costs and accrual methods, update—for a task within 
the Cost table in order to track its progress against project costs. You do not enter any values into this table when 
tracking project progress; Microsoft Project enters them based upon changes you have made to duration and work.
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Variance

• In project management, variance is the difference 
between the baseline and the actual performance 
for any of the key constraints for a project—scope, 
time, and cost. Variance can be positive, indicating 
that the project is exceeding the plan; or it can be 
negative, indicating that the project is under the 
plan.

• Microsoft Project includes a number of built-in 
tools that will display variance for the three key 
factors for your project:

• The Variance table shows variances in planned and 
actual dates and duration.

• The Work table shows variances in planned and 
actual work.

• The Cost table shows variance between planned 
and actual costs.

• You can view their respective commands in 
the Tables drop-down from the Data command 
group on the View tab.

•
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The Project Statistics Dialog Box

• The Project Statistics dialog box displays overall statistics for five key categories for your project: start and finish dates, 
duration, work, and cost.

• For start and finish dates, it displays the current start and finish dates, the start and finish dates set in the initial baseline, the 
actual start and finish dates (if your project is in progress, only a value for the start date will display), and the variance 
between the baseline start and finish dates and the actual start and finish dates.

• For duration, work, and cost, it displays the current amounts of scheduled time, work hours, and costs that exist in the 
project plan; the scheduled time, work hours, and costs as set in the initial baseline; the actual amount of time, work hours, 
and cost already spent on the project; and the remaining amount of time, work hours, and cost left on the project.
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You can open the Project Statistics dialog box by 
selecting the Project Information command from 
the Properties command group on the Project tab, and 
then selecting the Statistics button.



Baselines in the Gantt Chart

• To compare your current project status 
to any of the baselines you have created 
for your project, you can view the 
baseline in the Gantt Chart. In the Gantt 
Chart view, select the baseline that you 
want to view from the Baseline drop-
down from the Bar Styles command 
group on the Gantt Chart Tools 
Format tab. Microsoft Project will 
display baseline bars below the task bar 
in a different color, to show the tasks as 
they were initially scheduled in the 
selected baseline.
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Slippage

• Slippage is the amount of additional schedule duration caused by failing to meet a scheduled date in the project plan. For 
example, missing the deadline for a milestone because a task took a week longer than planned could cause an additional two 
weeks of slippage in the project plan when all affected subsequent tasks and resources are accounted for.

• You can view slippage to see which tasks have slipped from their initial schedule in the baseline. In the Gantt Chart view, 
select the baseline you want to view slippage against from the Slippage command drop-down in the Bar Styles command 
group on the Gantt Chart Tools Format tab. Microsoft Project will display the slippage for any slipped tasks as a line between 
the baseline bar and the task bar
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The Tracking Gantt View

• Using the Tracking Gantt view, you can view how your tasks are progressing over time and whether their start and finish 
dates are slipping. The Tracking Gantt compares the start and finish dates for your tasks as they were initially planned in 
the selected baseline and the scheduled or actual start and finish dates for your tasks as they exist in the current project 
schedule.

• To view the difference between your initial plan and the current schedule, select Tracking Gantt from any of 
the View command drop-downs. Microsoft Project will display the baseline bar below the task bar, with tasks that are part 
of the critical path in red.
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Views

• Views in Microsoft Project provide a visual representation of project data that can be useful for tracking your project 
throughout its lifecycle. You can use a specific view to focus on specific aspects of your project or view specific types of 
data. For instance, there is a view that helps you track your progress and a view that shows you how your resources are 
being utilized. Typically, views contain a combination or two or more tables and/or charts.

Default Views
• There are a number of built-in views that are considered the most commonly used views; they are accessible from the 

various view commands on the various ribbon tabs. The View drop-down lists them all on the Task and Resource tabs, and 
they are found in the various commands of the Task Views and Resource Views command groups on the View tab.
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View Description Use

Calendar Shows the tasks in the project schedule in calendar 
format. You can view tasks by month, week, or a 
custom time period you select.

To see which tasks are scheduled for a 
particular time period.

Gantt Chart Shows project tasks in two ways: as a list and as bars 
plotted against the project timeline.

To see a list of your tasks and a graphical 
representation of when they are scheduled to 
occur.



The More Views Dialog Box

• In addition to the built-in views provided from the view commands, there are a number of other views from which you can 
choose to display your data in Microsoft Project. These additional view are listed in the More Views dialog box, which you 
can access by selecting More Views from any of the view command drop-downs.
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View Description Use

Bar Rollup Shows a simplified, high-level view of all 
tasks in the project plan.

To see a high-level summary of the 
project.

Descriptive Network Diagram Shows more information for each node 
than in the regular network diagram 
view.

To see a more detailed graphical 
representation of how tasks are 
sequenced.


